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1. UVOD 
 
Savijanje spada u grupu postupaka tehnologije plastičnog deformisanja koji se često 
primjenjuju. Savijanje omogućava izradu širokog asortimana proizvoda  dimenzija od 
dijelova milimetra pa do nekoliko metara. Dijelovi složenih geometrija izrađuju se u više 
operacija. 
Karakteristika procesa savijanja je, u većini slučajeva, lokalno plastično deformisanje. 
Zona deformisanja tada obuhvata manji dio zapremine komada, mada ima postupaka 
gdje se deformiše kompletna zapremina (kružno savijanje). 
Savijanje se primjenjuje kako u maloserijskoj, tako i u veliko serijskoj proizvodnji, 
kombinujući ga sa ostalim procesima obrade (probijanje, prosijecanje, razdvajanje, 
zavarivanje...) i zauzima značajno mjesto u savremenoj proizvodnji raznih dijelova. Kao 
poluproizvodi za dalju obradu savijanjem se najčešće koriste limovi u vidu trake ili table, 
ali se ne isključuje mogućnost prerade drugih poluproizvoda: žica, punih profila, šipki ili 
cijevi. Debljine limova za savijanje kreću se od stotih dijelova milimetra pa do nekoliko 
desetina milimetara. Tehnologija izrade dijelova savijanjem nudi niz prednosti, 
konstrukcije su lakše, proizvodni proces je jednostavniji što se svakako ogleda kroz 
ekonomske aspekte.  
Proces savijanja se može kombinovati i sa ostalim procesima obrade deformacijom: 
prosijecanjem, probijanjem, izvlačenjem i raznim drugim oblikovanjima. Ova tehnologija 
zauzima vidno mjesto u izradi dijelova za laka i teška vozila, traktore, šinska vozila, 
poljoprivredne mašne, aparaturu, razne građevinske proizvode, proizvode u avio 
industriji, bijeloj tehnici itd. 
U zavisnosti od dimenzija i oblika komada, profila poluproizvoda i samog karaktera 
proizvodnje, proces savijanja se obavlja: 
• Alatima na presama,  
• Valjcima na rotacionim mašinama za savijanje, 
• Posebnim uređajima na specijalnim mašinama za savijanje. 
U ovoj studiji slučaja je analizirana mogućnost izrade UD-profila. UD-profil koristi se u 
građevinarstvu, suha gradnja, za uređenje enterijera. Osnovni materijal koji se koristi u 
suhoj gradnji je gips – prirodni materijal koji se već vijekovima rado i često koristi, a 
odlikuje se izvrsnim fizikalnim i biološkim svojstvima, hemijski je neutralan, nije zapaljiv i 
ne sadrži štetne materije, lako se oblikuje i prerađuje, a upotreba i primjena vrlo su 
jednostavne. Najrazličitiji tipovi gipsanih ploča pričvršćuju se na metalne konstrukcije 
sastavljene od različitih vrsta profila što omogućuje raznovrsna prostorna rješenja. UD-
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profil je dio konstrukcije (tzv. „roštilj“) na koju se postavljaju gips karton ploče pomoću 
samourezivih vijaka. 
Posebna pažnja je posvećena postupku odrade profilnog savijanja pomoću valjaka. 
Prezentovana je proizvodna oprema, mašina za profilno savijanje pomoću valjaka 
proizvođača „DALLAN“ Italija, u proizvodnom preduzeću „K&C“, Laktaši, BiH. Meterijal 
od koga se pravi UD-profil je pocinčani lim debljine 0,6 mm. Modeliranje alata, valjaka, 
je vršeno u programskom paketu „CATIA V5R19“ proizvođača „Dassault Systèmes”, a 
numerička simulacija procesa profilnog savijanja pomoću valjaka izvršena je u 
programskom paketu „Simufact.forming 10.0“ proizvođača „Simufact“ Njemačka, koji je 
instaliran i licenciran na Mašinskom fakultetu Banja Luka u Kooperativnom Trening 
Centru. 
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2. SAVIJANJE LIMA 
 
Savijanje je postupak obrade deformisanjem kojim se obrađuju limovi, trake, elementi 
od žice, cijevi, šipkasti materijali kao i pripremci iz ovih polufabrikata. Savijanje se 
ostvaruje pomoću momenta savijanja. U zavisnosti od deformacije izazvane momentom 
savijanja razlikuje se: elastično-plastično savijanje i čisto plastično savijanje. 
Savijanjem je moguće izrađivati profile najrazličitih oblika od kojih su najčešći U i V 
oblici. Da bi se moglo pravilno i ekonomično odrediti tehnologija za savijanje lima 
potrebno je detaljno razmotriti: 
• Crtež izratka, sa svim njegovim zahtjevima: oblik i vrsta geometrijskih mjera, 

tehnologičnost i vrsta materijala. 
• Broj komada. U zavisnosti od veličine broja komada donosi se odluka kojom 

tehnologijom se izrađuje profil. 
• Analiza uslova pod kojim se ostvaruje optimalan proces obrade tj. izrada izratka sa 

najmanjim brojem radnih operacija i naknadnih dorada uz obezbjeđenje potrebnog 
kvaliteta i mehaničkih karakteristika izratka. 

Dimenzije UD-profila (Slika 1) definisane su DIN 18182 normom. Dužina profila je 3000 
mm, širina (unutrašnja) 27 mm i visina krakova 28 mm, debljina pocinčanog lima je 0,6 
mm, površinska zaštita je 170-200 g/m2 cinkove obloge. 

 

  
Slika 1. UD-profil 

 
Analizom dimenzija UD-profil dolazi se do zaključka da je navedeni profil moguće 
izrađivati na sledeće načine: 
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• Savijanjem na abkant presama. 
• Profilnim savijanjem pomoću valjaka. 
Pošto se radi o velikoserijskoj proizvodnji posebna pažnja i prednost će se dati procesu 
savijanja pomoću valjaka.  
 
2.1 NAPONSKO DEFORMACIONO STANJE 
 
Uslijed djelovanja momenta savijanja (Slika 2) doći će do savijanja nosača. Da bi se 
uočile deformacije, posmatraju se promjene koje nastaju na elementu dužine dx. Dva 
paralelna presjeka AB i A’B’ nosača, na rastojanju dx, nakon opterećenja će se 
zakrenuti jedan u odnosu na drugi za ugao dϕ. Pod uticajem momenta M nosač se 
deformiše tako da se gornja vlakna A-A’ skraćuju, a donja B-B’ izdužuju. Između njih će 
ležati vlakna, koja se pri ovom opterećenju ne mijenjaju i obrazuju neutralnu površinu, a 
njen presjek sa ravni savijanja daje neutralnu liniju (n-n). 

  
Slika 2. Savijanje i neutralna linija 

Dužina neutralnog vlakna poslije deformisanja ostaje nepromijenjena i jednaka 
prvobitnoj dužini. 

nnn dx dρ ϕ= = ⋅  
Jedinična deformacija vlakna C-C’ na rastojanju z ispod neutralne linije iznosi: 

0 n

l dx z
l dx

ε
ρ

Δ Δ
= = =  ili 0

0

n n

n n

l l d d
l d

ρ ϕ ρ ϕ ρ ρ
ε

ρ ϕ ρ

− − −
= = =  

Nakon savijanja najveću deformaciju će pretrpjeti vlakna koja su najudaljenija od 
neutralne linije. Ukoliko neutralna linija prolazi kroz središte presjeka, tada je: 
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max 2
n n

n n n

s R rρ ρ
ε

ρ ρ ρ

− −
= = =  

U zavisno od vrste i veličine napona koji se javljaju u obratku pri savijanju  problem 
savijanja se tretira na dva načina i to kao: 
• Savijanje u elastično-plastičnom području 
• Čisto plastično savijanje. 
Moment savijanja u elastično-plastičnom području će biti: 

0

/2
2

0.2
0 0

2
2 ( )

z s

v
z

M z dA z dA R W S
z

σ= ⋅ + ⋅ = ⋅ +
⎡ ⎤
⎢ ⎥
⎢ ⎥⎣ ⎦
∫ ∫  

Pod pretpostavkom pravougaonog poprečnog presjeka obratka te primjenom Hooke-
ovog zakona pri izračunavanju visine elastičnog deformisanog dijela, prethodna relacija 
se može pojednostaviti, pa će moment savijanja pri elastično-plastičnom savijanju biti 

2

0.2 4
b s

M R
⋅

= ⋅  

Moment savijanja u čisto plastičnom području: 
2

4
b s

M kβ
⋅

= ⋅  

Moment savijanja s obzirom na ojačavanje materijala iznosi: 
2

4m

b s
M n R

⋅
= ⋅  

gdje je: 
n  – korekcioni koeficijent ojačavanja koji se kreće u granicama n=1,6–1,8 
Rm – čvrstoća zatezanja. 
 
2.2 PROFILNO SAVIJANJE NA ABKANT PRESAMA 
 
Ovaj tip savijanja predstavlja ugaono savijanje komada veće širine savijene zone i 
dužine od nekoliko metara na abkant presi (Slika 3). 
Pritiskivač je velike dužine, nožastog oblika I najčešće izvodi jednougaono savijanje uz 
pomoć univerzalne matrice. Međutim, oblikovanje je uglavnom višeoperaciono (više 
jednougaonih savijanja uz zamjenu alata) tako da se dobijaju i vrlo složeni profili.  
Ovaj proces savijanja može se automatizovati i pogodan je za numeričko upravljanje 
tako da se sve savremenije prese grade sa kompujuterskim upravljanjem. 
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Osnovna karakteristika profilisanja pomoću valjaka je postupak formiranja zadanog 
oblika (višefazno oblikovanje) koje se postiže prolaskom obratka kroz veći broj jedinica 
za savijanje (Slika 6).  

 
 

 
 
 
 
 

 
 
 
 

Slika 6. Šema procesa profilnog savijanja i faze oblikovanja 
 
Karakteristike ovako dobijenih profila i procesa profilisanja su: 
• Širok asortiman poprečnih presjeka profila sa maksimalnom nosivošću i racionalnim 

iskorišćenjem materijala, 
• Mogućnost stvaranja lakih konstrukcija, 
• Debljina lima je prilično ujednačena po poprečnom presjeku obratka, 
• Dodatna obrada hladnooblikovanih profila je minimalna, 
• Hladno oblikovani profili su ojačani, 

1 – Radni komad 
2 – Gornji valjak 
3 – Donji valjak 
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• Tačnost mjera poprečnog presjeka je viša u odnosu na profile dobijene drugim 
postupcima,  

• Profili imaju visok kvalitet površine što omogućuje kvalitetno nanošenje dekorativnih 
prevlaka i boje i povećanje antikorozivnih osobina, 

• Tehnološki postupak profilisanja lima pomoću valjaka može se komponovati sa 
drugim postupcima u istoj proizvodnoj liniji, 

• Mašine za hladno oblikovanje profila sa valjcima su vrlo produktivne i obično 
potpuno automatizovane, 

• Alati za profilisanje su veoma trajni, a njihova izrada nije komplikovana. 
Profilno savijanje pomoću valjaka suštinski se razlikuje u odnosu na postupak izrade 
profila pomoću specijalnog alata na univerzalnoj presi i u odnosu postupak profilisanja 
na abkant presi. Kod profilisanja sa valjcima obradak se kreće aksijalno, zona 
deformacije je mala, deformaciona sila je takođe manja, a dužina obratka je 
neograničena. 
Poznavanje distribucije opterećenja na kontaktnim površinama valjaka značajno je za 
određivanje ukupnog opterećenja i obrtnih momenta valjaka i vratila na osnovu kojih se 
određuje i ukupna snaga pogonskog agregata. 
U projektovanju tehnologije izrade profila spade čitav niz aktivnosti, a osnovne su: 

1. Analiza tehnologičnosti konstrukcije profila 
2. Izbor kvaliteta polaznog materijala 
3. Izvor tehnološke šeme profilisanja 
4. Utvrđivanje položaja profila u valjcima 
5. Određivaje dimenzija pripremka 
6. Izbor režima profilisanja 
7. Konstrukcija alata (valjaka) 
8. Izbor mašine za profilisanje. 

 
2.3.1 Analiza tehnologičnosti konstrukcije profila 
 
Često su oblik i dimenzije hladno oblikovanih profila određeni standardima ili internim 
normama pojedinih proizvođača. Međutim, nekada se javlja potreba za oblicima profila 
koji odstupaju od standardnih. Pri konstruisanju novog profila potrebno je imati u vidu 
određena pravila koja doprinose boljoj tehnologičnosti, te omogućuju lakšu izradu 
profila: profil mora odgovarati konstrukcionim i eksploatacionim zahtjevima uz 
ispunjavanje tehnoloških mogućnosti za proizvodnju, potrebno je uskladiti odnos 
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dimenzija profila prema debljini materijala u skladu sa preporukama, uskladiti radijus 
savijanja sa preporučenim vrijednostima imajući u vidu minimalne vrijednosti istih, 
izvršiti pravilan izbor vrste materijala s obzirom na deformacije koje nastaju u pojedinim 
zonama profila i predvidjeti eventualne dodatke za naknadnu mehaničku obradu profila. 
Poslije projektovanja profila određuje se širina pripremka za njegovu izradu. Za pravilno 
oblikovanje profila preporučuje se širina obratka u zavisnosti od debljine materijala. 
Maksimalne dimenzije profila određene su prije svega mogućnostima raspložive 
opreme. Tu se prije svega mora voditi računa o maksimalnoj širini kao i o maksimalnoj 
visini profila koja je limitirana maksimalnim prečnikom valjka. 
Minimalni radijusi savijanja limitirani su plastičnim svojstvima polaznog materijala. Po 
pravilu minimalni radijus ne treba da je manji od debljine materijala. 
 
2.3.2 Izbor polufabrikata za izradu profila i položaj profila u valjcima 
 
Kada je u pitanju kontinualni proces profilisanja pripremak za izradu profila je lim 
odgovarajuće širine i debljine namotan u bunt. Kvalitet pripremka u pogledu njegovih 
dimenzija, prije svega debljine i širine, a takođe i u pogledu mehaničkih i elastičnih 
svojstava, bitno utiče na stabilnost procesa profilisanja i kvalitet profila. Debljina 
materijala određuje zazor valjaka i mora se nalaziti u granicama definisanim 
standardom. Širina pripremka utiče na konačne dimenzije profila te se ona mora držati 
u određenim granicama. Eventualne greške u proizvodnji lima, kao što su neravnine u 
obliku talasa, oštećenja bočnih ivica lima nepovoljno se odražavaju na kvalitet profila. 
Za izradu profila rotacionim alatima koriste se uglavnom hladno valjani dekapirani 
limovi, a u određenim slučajevima i toplo valjani limovi. Često se koriste i nerđajući 
čelici na bazi hroma i nikla. Limovi od aluminijuma i njegovih legura takođe se koriste za 
izradu profila, pri čemu se režimi obrade podešavaju u skladu sa mehaničkim 
osobinama materijala. Izrada profila postupkom rotacionog profilisanja moguća je i od 
plakiranih, zatim plastificiranih, obojenih i limova sa perforacijom. 
Položaj profila u odnosu na horizontalnu osu valjka mora da obezbijedi sledeće 
zahtjeve: 
a) Izradu profila sa najprostijim oblikom valjaka; 
b) Pravilan brzinski režim profilisanja (minimalno prisustvo klizanja); 
c) Visok kvalitet površine profila; 
d) Visoku trajnost valjaka i niske troškove izrade i održavanja. 
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Režimi profilisanja nisu identični u svim fazama obrade. 
Kod kontinualnog režima profilisanja kritična je prva faza obrade i defekti se najčešće u 
njoj javljaju. 
U donjoj tabeli dati su podaci o uglu savijanja za pojedine tipove profila i pojedine faze 
obrade (prva, sledeća, posljednja): 

Vrsta profila Faza 
obrade  

Ugao savijanja za režime profilisanja 
Pojedinačni Δαo Kontinualni Δαo 

U – profil  Prva 
Sledeća 
Posljednja 

8 – 10 
12 – 14 

8 – 2 

20 
15 – 20 

15 
Ugaonik Prva  

Sledeća 
Posljednja 

6 – 8 
8 
1 

18 
15 
12 

 
Takođe važan parametar koji definiše režim profilisanja je veličina radijusa po fazama 
obrade u kombinaciji sa rastojanjem centra zaobljenja. Moguće su tri varijante: 
1. Promjenljivi radijus zaobljenja sa konstantnim rastojanjem centra  
2. Konstantan radijus zaobljenja, sa promjenjljivim rastojanjem  
3. Konstantna veličina radijusa i konstantna veličina rastojanja između centra 

zaobljenja. 
U prvom slučaju veličina radijusa savijanja određuje se na osnovu dužine dijela profila 
koji se definiše i na osnovu ugla savijanja po fazama. Radijus savijanja najveći je u 
prvoj fazi obrade i smanjuje se na zadatu vrijednost u poslednjoj fazi. Ovakav postupak 
profilisanja je povoljan i obezbjeđuje minimalno stanjenje materijala zbog toga što je 
opterećenje raspoređeno po cijeloj dužini zone deformacije. 
U drugom slučaju deformacija počinje na periferiji zone i kreće se ka centru obratka. 
Opterećenje valjaka raste iz faze u fazu i najveće je na kraju procesa profilisanja. 
Međutim, ovakav postupak obezbeđuje izradu profila sa tačnim radijusom savijanja sa 
manjim brojem faza obrade. Rastojanje centra zaobljenja po fazama određuje se na 
osnovu ugla savijanja i veličine nedeformisanog dijela zone. 
U trećem slučaju profilisanje se izvodi sa konstantnim radijusom i konstantnim 
rastojanjem centra zaobljenja. U ovom slučaju profilisanje se izvodi sa deformacijom 
koja se kreće od centra ka periferiji. Problem koji je prisutan kod ovog načina 
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Radi smanjenja trenja na konusnim površinama valjaka donji i gornji valjak se izrađuju 
sa različitim uglom konusa. 
Zbog povećanja dužine obratka iz faze u fazu osnovni prečnik donjeg valjka se 
povećava po fazama: 

( ) ( )1od n od nD K D −= ⋅  

gdje je: 
 K=1 – 1,004 – korekcioni factor. 
 

3. PROIZVODNA OPREMA I MATERIJAL 
 
Mašina za profilno savijanje pomoću valjaka (Slika 9) nalazi su u proizvodnom 
preduzeću „K&C“, Laktaši, BiH. Mašina je od proizvođača DALLAN model broj LS-T4R-
12-300 COMBI. Kapacitet mašine je 60 m/min. Mašina zadovoljava sve potrebne 
evropske norme, što se potvrđuje posjedovanjem CE znaka. 
  

 
Slika 9. Mašina za profilno savijanje pomoću valjaka 

 
Mašina je sastavljena od više agregata od kojih se navode najbitniji: nosač trake, modul 
za podmazivanje, dvanaest parova valjaka, leteće makaze za sječenje i upravljački 
modul. 
Nosač trake služi za nošenje kolutova trake određenje širine i težine. Maksimalna masa 
koluta trake ograničena je na 2 tone. Nosač trake je opremljen sa pneumatskom 
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kočnicom, kada se zaustavi proces proizvodnje nosač se takođe zaustavlja i ne dolazi 
do nepotrebnog odmotavanja trake.  
Modul za podmazivanje sastavljen je od dva valjka presvučena sa tkaninastom 
košuljicom kroz koje se dozira emulzija vode i ulja za podmazivanje i hlađenje.  
Parovi valjaka predstavljaju alate za profilisanje. Valjci su modularno projektovani, tako 
da komponovanjem valjaka dobijaju se alati za različite profile. Valjci se postavljaju na 
vratila koja imaju svoj pogon. Razmak između parova valjaka je 245 mm. 
Leteće makaze odsijecaju profil na zadanu dužinu. Leteće makaze putuju zajedno sa 
profilom i u „letu“ odsijecaju profil. Modul za odsijecanje pogonjen je hidrauličnim 
agregatom, a samo postolje se kreće pomoću recirkulacionog vretena. 
Upravljački modul čuva osnovni mašinski program i podatke potrebne za proizvodni 
proces. Sastavljen je od displeja i funkcionalnih tipki. Na displeju se mogu isčitavati 
parametri procesa, a pomoću funkcionalnih tipki unositi osnovni podaci o procesu: broj 
komada, dužina profila i ostali parametri. 
 

 
Slika 10 Valjci postavljeni na mašinu 

 
Materijal za izradu UD-profila je hladno valjana pocinkovana traka debljine 0,6 mm DIN 
oznake St 02Z, JUS oznake Č.0146. Pocinkovana traka se nabavlja u kolutovima širine 
800, 1000, 1200 mm, a da bi se prilagodila za izradu UD-profila reže se kružnim 
noževima.  
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Slika 11.  Traka u kolutu i razrezana na kružnim makazama 

 

4. MODELIRANJE I NUMERIČKA SIMULACIJA 
 
Projektovanje podržano računarom obuhvata aktivnosti u kompjuterskom okruženju, 
kome je pridružena interaktivna kompjuterska grafika za kreiranje modela proizvoda i 
njegovih komponenti, njihovih modifikacija, analizu i optimizaciju. Dizajner i projektant 
može manipulisati dobijenim modelom, u fazi njegovog konceptualnog dizajna, 
razmotriti sve njegove alternative, i izvršiti brze promjene na modelu, ka dostizanju 
specifičnih zahtjeva u projektovanju. Da bi koncept modela proizvoda bio kvalitetan i 
održiv mora podržati ne samo fizički dizajn proizvoda, već i analizu, testiranje, 
optimizaciju dizajna, simulaciju, proizvodnju, montažu, održavanje i mnoge druge 
procese u razvoju proizvoda. Današnji CAD alati nisu namijenjeni samo geometrijskom 
modeliranju i manipulisanju oblicima, već i optimizaciji dizajna. Oni uključuju analizu 
tolerancija, precizni proračun zapremine i mase modela, simulacije metodom konačnih 
elemenata i analizu rezultata simulacije. 
Inženjering podržan računarom (CAE – Computer Aided Engineering) je tehnologija u 
kojoj se kompjuterski sistemi koriste za analizu CAD modela, dozvoljavajući projektantu 
da simulira i analizira ponašanje proizvoda, kako bi se njegov dizajn poboljšao i 
optimizovao. Najšire korišćena metoda za kompjuterske analize u inženjerstvu je 
metoda konačnih elemenata. Koristi se za određivanje napona, deformacija, transfera 
toplote, protoka fluida i rješavanje ostalih problema. 
CAD programski paket, i ako on spada u CAE programski paket, korišćen u radu je 
CATIA V5R19, CAE programski paket takođe korišćen u radu je Simufact.forming 10.0. 
koji će u daljem biti opisani. 



www.wbc-vmnet.rs 
www.ctcunibl.rs 
fax: +387 51 462 321 
  
                                                                              

___________________________________________________________________________________ 
 
 

_____________________________________________________________________ 
20 

 

 
4.1 MODELIRANJE PROCESA 
 
Modeliranje procesa izvršeno je po dokumentaciji proizvođača mašine i alata „DALLAN“ 
u programskom paketu CATIA V5R19. Modeli valjka su predstavljeni iz jedna, a ne 
komponovani iz modula, radi lakše i brže pripreme numeričke simulacije. Na Slici 12 
prikazan je osnovni 3D model procesa izrade UD-profila. 
 

 
Slika 12.3D model procesa izrade 

 
Na Slici 13 ilustracije radi date su faze oblikovanja UD-profila sa osnovnim 
konstrukcionim detaljima valjaka.  
 

   

2 1 3
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Slika 13. Modeli valjaka po fazama izrade UD-profila 
 
Modeliran je i 3D proces postupnog savijanja UD-profila po fazama prikazan na Slici 14. 
 

4 5 6

7 8 9
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Slika 14. 3D model procesa postupnog savijanja UD-profila 

 
 Na Slici 15 prikazane se faze oblikovanja sa uglovima savijanja i „cvjetni“ 
dijagram, pogodan za sagledavanje svih faza procesa na jednom mjestu. 

  
Slika 15 Faze oblikovanja UD-profila i „cvjetni“ dijagram 
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4.2. NUMERIČKA SIMULACIJA 
 
Kompjuterske simulacije su postale koristan dio matematičkog modeliranja mnogih 
prirodnih sistema u fizici, hemiji i biologiji, društvenim naukama i inženjerstvu. 
Simulacije se mogu koristiti za istraživanje i sticanje uvida u nove tehnologije i 
optimizaciju postojećih tehnologija. 
Kompjuterski program koji je korišten u ovoj studiju slučaja je Simufact.forming 10.0, 
razvijen posebno za obrade deformisanjem. Kao konzistentno unapređenje dugo 
razvijanih softverskih rješenja za simulacije procesa MSC.SuperForm i 
MSC.SuperForge od MSC.Software, obe komplementarne tehnologije i softverski 
pristupi (MSC.Dytran i MSC.Marc solver) su objedinjeni u proizvod za simulaciju 
proizvodnje – Simufact.forming 10.0. Kompanija Simufact Engineering GmbH iz 
Njemačke održava, distribuira i unapređuje navedeni kompjuterski program. 
Simufact.forming 10.0 softver je razvijen za analizu i simulaciju gotovo svih obrada 
deformisanjem, nezavisno od: 
• temperature procesa (hladna, topla ili polu-topla obrada) 
• korišćene mašine (mehaničke prese, čekići ili ekscentar prese, mašine za valjanje 

ili mašine za orbitalno kovanje) 
• materijala obratka (niskougljenični i legirani čelici, aluminijum i drugi obojeni metali, 

titanijum i legure na bazi nikla) 
• vrste procesa (kovanje u zatvorenim alatima ili istiskivanje, duboko izvlačenje, 

slobodno kovanje, savijanje ili slobodno oblikovanje, valjanje i profilno valjanje, čak i 
u objedinjenim procesima i primjeni alata sa elastičnim oslanjanjem) 

• tip analize (zapremnisko ili oblikovanje lima, procjena tečenja materijala i analiza 
opterećenja alata). 

Računarski program Simufact.forming 10.0 je instaliran i licenciran u Kooperativnom 
Trening Centru na Mašinskom fakultetu Banja Luka, Univerzitet u Banjoj Luci  u sklopu 
Tempus Projekta WBCVMnet. 
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4.2.1 Kreiranje procesa za simulaciju u Simufact.forming 10.0 
 
Simufat.forming 10.0 ima široku lepezu alatki koje omugućavaju i olakšavaju definisanje 
procesa koji se simulira ili optimizuje. U daljem izlaganju pokazana je njegova primjena 
na konkretnom primjeru profilnog savijanja pomoću valjaka, čime je ukazano na sve 
mogućnosti ovog računarskog programa.  

 
1)  Start Programskog paketa simufact.forming 10.0 
Simufact.forming 10.0 je potpuno prilagođen okruženju Windows operativnog sistema 
tako da se startovanje vrši kao i ostalih programa.  
 
2) Kreiranje novog procesa  
U glavnom prozoru potrebo je kreirati novi pojekat klikom na padajući meni File→New 
Project. 
U ovom dijalog prozoru se podešavaju osnovne postavke procesa deformisanja: vrsta 
obrade u meniju pod Type, stanje odrade (toplo, hladno) u Forging (Hot, Cold), način 
simuliranja pod Simulation (2D,3D) i željeni solver (konačni elementi ili konačne 
zapremine) pod Suggested solver (FE,FV). Program postavlja sam, automatski, ostale 
paramete po predefinisanim vrijednostima zavisno od izabranog procesa.  
U datom slučaju bira se vrsta procesa, profilisanje (Rolling) u hladnom stanju (Cold), 
broj alata, odnosno valjaka, može se podesiti unaprijed pod Dies ili se dodaju poslije u 
procesnom prozoru (Processes Tree Window). Klikom na dugme OK pojavljuje se 
glavni prozor Simufact.forming 10.0 (Slika 16). Program automatski postavlja osnovne 
elemente procesa za svaku simulaciju u procesnom prozoru (Process Tree Window) 
na lijevoj strani. Popisni prozor (Inventory Window) je u sredini i na desnoj strani je 
prozor modela (Model Window). 
Osnovne komponete svake simulacije u procesnom prozoru  (Process Tree Window) 
su: 
- Gornji alat (UpperDie), 
- Donji alat (LowerDie), 
- Radni komad (Workpiece), 
- Temperatura okoline (Ambient Temperatre), 
- Kontrola procesa (Forming Control). 
Kada se kreira novi projekat simulacije poželjno mu je dati jedinstveno ime. 
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Slika 16. Glavni prozor simufact.forming 10.0 

  
3) Definisanje geometirije alata i radnog predmeta 
Definisanje geometrije alata i radnog predmeta vrši se klikom miša na padajući meni  
Insert→Model. Može se uvoziti geometrija iz prijašnjih rezultata tasterom From 
Result..., kreiranje jednostavnih geometrija Auto shape... modulom, uvoziti modele iz 
već kreiranih dokumenata tasterom From file... ili preuzimati CAD modele tasterom 
CAD import....  
Pošto su modeli valjaka i radnog predmeta kreirani u CAD paketu CATIA V5R19  i 
sačuvani u standardizovanim dokumentma ekstenzije *.stl koristi se opcija  From file.... 
Kada su učitani modeli u Inventory Window, potrebno je modele dodijeliti 
odgovarajućim elementima u procesnom stablu (Process Tree Window), što se 
postiže „drag and drop“ funkcijom, odnosno uzimajući i dodjeljujući  odgovarajuće 
geometrije elementima u procesnom stablu (Slika 17). 
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Slika 17. Definisana geometrija procesa profilisanja 

 
4) Definisanje materijala 
Klikom na padajući meni Insert→Material dobijaju se četiri tastera: 
- Manual...; manuelno unošenja podataka o materijalu, 
- Library...; interna biblioteka materijala,  
- From MatILDa...; baza materijala,  
- From JMatPro...; baza materijala. 
Dodjeljivanje materijala radnom predmetu vrši se „drag and drop“ funkcijom. 

 
5) Definisanje prese 
Pošto se u programskom paketu ne nalazi mašina za profilno savijanje valjcima, bira se 
hidraulična presa, tako da translatorno kretanje izvode valjci, a ne traka kako je to u 
realnom slučaju. Učitavanje prese vrši se klikom na padajući meni 
Insert→Press→Manual.... Podešavanje brzine prese vrši se pod Velocity(V) 
unošenjem 1 (m/sec). Potrebno je da se presa „drag and drop“ funkcijom dodijeli 
porecesu, zatim se alati istom funkcijom dodjeljuju presi. 
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6) Definisanje trenja  
Klikom na padajući meni Insert→Friction→Manual... dobija se dijalog prozor, u kome 
se podešava vrsta trenja (Type of Friction), koeficijent trenja (Coulomb Friction) i 
habanje alata (Die wear). 
 
7) Podešavanje temperature 
Potrebo je podesiti temperaturu okoline što se postiže dvoklikom na Ambient 
Temperature u Process Tree Window unošenjem 200 (C). Temperature alata i radnog 
predmeta dodaju se klikom na padajući meni  Insert → Heat →Die →Manual  i Insert 
→Heat →Workpiece →Manual postavljajući takođe 200 (C). 
  
8)  Kontrola procesa (Forming Control) 
Dvoklikom na Forming u Proces Tree Window  dobija se dijalog prozor za finalna 
podešavanja simulacije. U pomenutom prozoru imamo meni sa sljedećim stavkama: 
- Stroke; služi za podešavanje hoda prese za pokretne alate, 
- Sub-stages; nudi pomoć pri pozicioniranju i podešavanju procesa, 
- Output divisions; služi za odabir prezentovanja rezultata po procentu izvršenja 

procesa, 
- Outpur results; daje mogućnost izbora izlaznih rezultata, 
- Step control; služi za podešavanje broja koraka u kojima solver rješava proces, 
- Advanced 
- Solver; odabir matričnog solvera i podešavanje, 
- Contact; podešavanje kontaktnih tolerancija,  
- Friction; podešavanje trenja cijelog procesa, 
- Symmetry; dodavanje ravni simetrije radi bržeg rješavanja simulacije, 
- Parallel; mogućnost iskorištenja više jezgrenih procesorskih jedinica, 
- Miscellaneous; podešavanje dodatnih opcija u procesu (gravitacija). 
 
9) Dodavanje kontaktne tabele i ravni simetrije 
Proces profilnog savijanja pomoću valjaka zahtijeva definisanje dodatnih modula za 
korektno simuliranje. Modul Contact table dodaje se klikom miša na padajući meni  
Insert→FE Contact table u kome se definiše kontakt između pojedinih elemenata 
procesa. Modul Symmetry Palne  dodaje se klikom miša na padajući meni Insert→ 
Symmetry Palne u kome se definiše pozicija ravni simetrije. 
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10) Kreiranje mreže konačnih elemenata 
Kreiranje mreže konačnih elemenata vrši se u dijalog prozoru Mesh do kojeg se dolazi 
dvoklikom na Mesh u Proces Tree Window pod elementom Workpiece. U 
navedenom prozoru vrši se odabir generatora mreže pod Mesher. Postoji više 
ponuđenih generatora: slMesh Terta, Patran Tetra, Overlay Hex, Sheetmesh, 
Ringmesh. U datom primjeru koristi se Sheetmesh. 
 
Ovim je završeno definisanje procesa simulacije, sledeći korak bio bi pokretanje 
simulacije, čekanje da računar obradi podatke i na kraju prezentovanje rezultata 
simulacije.  
 
4.2.2 Prezentovanje rezultata simulacije 
 
U programskom paketu Simufact.forming 10.0 moguće je prikazivati različite vrste 
rezultata, od proste animacije hoda prese, do naponskog stanja svakog konačnog 

elementa. Klikom na ikonu  u Result toolbar dobija se prozor (Slika 18) sa 
ponuđenim raznim vrstama rezultata. Dvoklikom na željenu vrstu rezultata (None, 
Effective Plastic Strain, Effective Stress, Temperature, Material Flow...) otvara se 
novi prozor sa odabranim rezultatima. 

 
Slika 18. Prozor za odabir rezultata 
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Radi poređenja sa modelovanim fazama procesa izrade UD-profila prvo se daje 
animacija procesa na Slici 19. (animaciju je moguće sačuvati u video format te je 
prezentovati kao video klip). 
 

 
Slika 19. Animacija procesa izrade UD-profila 

 
Na Slici 20 su prikazane efektivne plastične deformacije, legende u gornjim lijevim 
uglovima daju uvid u veličinu efektivne plastične deformacije po bojama s tima da, 
plava boja označava najmanju deformaciju odnosno jednaku nuli, a crvena najveću 
odnosno jednaku 0.539. Takođe kao i na prethodnoj slici daje se više slika u jednoj, radi 
lakšeg predstavljanja, bolja vizualizacija rezultata je ostvariva pomoću video klipova.  
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Slika 20.  Efektivna plastična deformacija 

 
Dvoklikom na Effective Stress u prozoru Result Selectioon dobijaju se prikazi 
efektivnih napona koji vladaju duž procesa obrade (Sliika 21). Legende u gornjim lijevim 
uglovima pokazuju rezultate po bojama, plava boja pokazuje efektivni napon od 0 MPa, 
dok crvena maksimalnu vrijednost od 590 MPa.  
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Slika 21. Efektivni napon 

 
Dijagrami toka materijala (Slika 22) se dobijaju dvoklikom na Material Flow u prozoru 
za odabir rezultata. Tok materijala daje se u jedinicama mm/sec, pokazuje tendenciju 
kretanje trake u vertikalnoj ravni. Više je koristan za zapreminska oblikovanja, pošto se 
dobija uvid u tok materijala (naročito kod istiskivanja).  
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Slika 23 Maksimalni efektivni napon 

 
Geometrijsko mjerenje radnog komada u bilo kojoj fazi oblikovanja vrši se komandom 

Measuring do koje se dolazi klikom na ikonu . Na Slikama 24 i 25 prikazane su 
osnovne geometrijske mjere izrađenog UD-profila.  
 

 
Slika 24. Izmjerena širina UD-profila 
 

Slika 25. Izmjerena visina krakova UD-
profila 
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Kao što se vidi izmjerena širina UD-profila je 27±0.2 mm što u potpunosti odgovara DIN 
18182 normi. Izmjerena visina krakova UD-profila je 28±1 mm što takođe odgovara 
navedenoj normi.  
Mjerenje debljine trake vrši se dvoklikom na Thickness u prozoru za odabir rezultata. 
Na Slikama 26 i 27 izmjerena je debljina materijala na početku procesa, koja iznosi 0.6 
mm i na kraju procesa izrade, čije mjere se kreću u rasponu od 0.6 do 0.599 mm. 
Takođe debljina trake je propisanja DIN 18182 normom i izmjerena debljina trake 
odgovara nevednoj normi.  
 

 
Slika 26. Debljina trake na početku procesa 
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Slika 27. Debljina trake poslije procesa izrade 

 
 
5. ZAKLJUČAK 
 
Primjena numeričkih simulacija je dobro provjeren i ekstremno koristan alat za 
predviđanje problema u industrijkoj proizvodnji i smanjenje vremena i troškova u 
razvoju novih proizvoda, te optimizaciji postojećih proizvoda.  
Korist od prikazane numeričke simulacije procesa izrade UD-profila je da se analizira 
postojeći način procesa izrade te uoče mogući koraci za optimizaciju procesa. 
Smanjenje faza oblikovanja uticalo bi na smanjenje troškova alata i utrošene energije. 
Promjenom geometrije valjaka uticalo bi se na veličine efektivnih deformacija i 
efektivnih napona, što bi takođe dovelo do ukupnog smanje troškova izrade. 
Revidiranjem same geometrije UD-profila, dodavanjem uzdužnih orebrenja uticalo bi se 
na čvrstoću profila.  
Bitna je sama priprema numeričke simulacije jer značajan faktor je vrijeme koje je 
potrebno za izračunavanje numeričke simulacije. Korištenjem novijih i savremenih 
kompjuterskih sistema, kompjuterskih sistema sa više procesorskih jedinica ili klastera 
kompjutera znatno bi dovelo do uštede vremena potrebnog za izračunavanje. Pravilnim 
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i podesnim izborom veličine i oblika konačnih elemenata utiče se ne samo na 
smanjenje vremena, već i na rezultate numeričke simulacije. Korišćenjem regenerisanja 
mreže (remeshing) konačnih elemenata znatnije se utiče na kvalitet rezultata 
numeričke simulacije. 
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